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ABOUT THIS GUIDE 

The Vernier Graphical Analysis and Graphical Analysis Pro User Manual is an extended guide 

detailing the features of the Graphical Analysis app both with and without the Graphical 

Analysis Pro features unlocked. This guide can be used with any platform-specific version 

including the versions for Windows® and macOS® computers, Chromebook™ notebooks, and 

iOS, iPadOS® and Android™ devices. 

This document reflects features available in Graphical Analysis version 5.8. 



Vernier Graphical Analysis™ and Graphical Analysis Pro —User Manual 

 

www.vernier.com/ga 3 

CONTENTS 
 

CHAPTER 1 —GETTING STARTED WITH  GRAPHICAL ANALYSIS ...................................................... 5 

I. Downloading Graphical Analysis ...................................................................................5 

II. Launching Graphical Analysis for the First Time .........................................................6 

III. Quick Start to Sensor Data Collection and Analysis ....................................................8 

IV. Looking at the Graphical Analysis Tools ...................................................................12 

V. Summarizing the Graphical Analysis Pro Features .....................................................15 

CHAPTER 2 —COLLECTING SENSOR DATA ........................................................................................ 18 

I. Getting Sensors Connected to Graphical Analysis .......................................................18 

II. Configuring Sensors ....................................................................................................25 

III. Modifying the Data-Collection Settings .....................................................................27 

IV. Setting Up the Display (Graph, Data Table, and Meters) ..........................................36 

V. Collecting Data ............................................................................................................39 

VI. Adding a Prediction ....................................................................................................43 

VII. Graph Matching with Motion Sensors ......................................................................44 

VIII. Analyzing Your Data ...............................................................................................46 

CHAPTER 3 —CONNECTING TO A DATA SHARING SOURCE ............................................................ 47 

I. Data Sharing with a LabQuest or Logger Pro Data Sharing Source ............................47 

II. Data Sharing with a Graphical Analysis Pro Data Sharing Source .............................49 

III. Using Graphical Analysis as a Data Sharing Client ...................................................50 

IV. Analyzing Your Data .................................................................................................51 

CHAPTER 4 —MANUALLY ENTERING DATA ........................................................................................ 52 

I. Setting up Columns .......................................................................................................52 

II. Entering Data in Your Data Table ...............................................................................55 

III. Setting Up the Display (Graph, Data Table, and Meters) ..........................................56 

IV. Analyzing Your Data .................................................................................................56 

CHAPTER 5 —CUSTOMIZING THE GRAPHS ......................................................................................... 57 

I. Changing What is Plotted on the Graph ........................................................................57 

II. Adjusting the Graph Style............................................................................................58 

III. Scaling the Graph .......................................................................................................60 

IV. Labeling the Graph .....................................................................................................62 

V. Modifying the Font-Size with Scale Factor .................................................................65 

  



Vernier Graphical Analysis™ and Graphical Analysis Pro —User Manual 

 

4 Vernier Software & Technology 

CHAPTER 6 —ANALYZING YOUR DATA ................................................................................................ 66 

I. Examining Data Points ..................................................................................................66 

II. Interpolating and Extrapolating Data ...........................................................................66 

III. Exploring Rate of Change (Tangent) .........................................................................68 

IV. Viewing Statistics .......................................................................................................68 

V. Viewing Integral ..........................................................................................................69 

VI. Applying a Curve Fit ..................................................................................................69 

VII. Apply FFT .................................................................................................................70 

VIII. Adding Additional Columns ....................................................................................70 

IX. Managing the Data .....................................................................................................72 

CHAPTER 7 —MANAGING GRAPHICAL ANALYSIS FILES .................................................................. 73 

I. Opening Files ................................................................................................................73 

II. Saving Files..................................................................................................................74 

III. Exporting Files ...........................................................................................................74 

IV. Printing from Graphical Analysis ..............................................................................76 

V. Starting a New Experiment File ..................................................................................76 

CHAPTER 8 —GRAPHICAL ANALYSIS PRO .......................................................................................... 77 

I. Unlocking Graphical Analysis Pro Features .................................................................77 

II. Accessing Sample Experiments in Graphical Analysis Pro ........................................78 

III. Data Sharing with Graphical Analysis Pro .................................................................80 

IV. Replaying Time-Based Data Collections ...................................................................82 

V. Adding a Video to a Graphical Analysis Pro Data File ...............................................84 

VI. Syncing a Video to a Time-Based Data Collection ....................................................86 

VII. Customized Curve Fits ..............................................................................................89 

VIII. Custom-Expression Calculated Columns ................................................................91 

IX. FFT Analysis ..............................................................................................................94 

CHAPTER 9 —APPENDIX ......................................................................................................................... 96 

I. Updating Graphical Analysis ........................................................................................96 

II. Updating the Graphical Analysis Pro Key ...................................................................98 

III. Sharing the Graphical Analysis Pro License Key ......................................................99 

IV. Updating the Firmware on a Go Direct Sensor ........................................................100 

V. Getting Additional Help ............................................................................................102 



Vernier Graphical Analysis™ and Graphical Analysis Pro —User Manual 

 

www.vernier.com/ga 5 

CHAPTER 1—GETTING STARTED WITH  
GRAPHICAL ANALYSIS 

I. Downloading Graphical Analysis 

Download Graphical Analysis from the Vernier website or the appropriate web store. 

• Windows and macOS computers—download from the Vernier website 

• Chrome computing devices—download from the Chrome Web Store 

• iOS and iPadOS devices—download from the App Store 

• Android devices—download from Google Play 
 
For up-to-date system requirements, visit www.vernier.com/graphical-analysis 
 

Licensing Information 

Vernier Graphical Analysis™ 

Graphical Analysis is a free app for Windows and macOS computers and can be installed on an 

unlimited number of computers. 

Graphical Analysis is a free app for Chrome, iOS, iPadOS, and Android distributed through the 

respective web stores. Terms and licensing are thus determined entirely by these stores. 

 

Vernier Graphical Analysis™ Pro 

Graphical Analysis Pro is a set of subscription-based features that extend the functionality of the 

Graphical Analysis app. These features are licensed for use on devices owned or used by 

students and faculty of the K–12 school or college department that purchased the subscription. 

Transferring the license key to anyone outside the school or college department is prohibited. 

Graphical Analysis Pro requires an installation of the Vernier Graphical Analysis app. 
 

Privacy Statement 

COPPA, SOPIPA, and FERPA Compliance 

Graphical Analysis and Graphical Analysis Pro comply with federal regulations pertaining to 

student privacy and safety in the following ways: 

• Graphical Analysis and Graphical Analysis Pro do not collect, request, share, or store any 

personal information from students or instructors. 

• Graphical Analysis and Graphical Analysis Pro do not display advertisements in the app. 

  

https://www.vernier.com/products/software/graphical-analysis/
https://chrome.google.com/webstore/detail/vernier-graphical-analysi/dncgedbnidfkppmdgfgidcepclnokpkb
https://itunes.apple.com/us/app/vernier-graphical-analysis-4/id1385963326?mt=8
https://play.google.com/store/apps/details?id=com.vernier.graphicalanalysis
http://www.vernier.com/graphical-analysis
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II. Launching Graphical Analysis for the First Time 

 

 

When Graphical Analysis is launched without any sensors connected to your device, the New 

Experiment box displays. Choose which type of experiment you want to do. 

Sensor Data Collection 

Click or tap  Sensor Data Collection to collect data from Vernier sensors. Supported sensors 

include the following: 

• Go Direct® sensors connected via USB or Bluetooth® wireless technology 

• Go!Temp® and Go! Motion® USB sensors 

• Wired LabQuest® sensors connected via a LabQuest interface (Original LabQuest, 

LabQuest 2, LabQuest 3, LabQuest Stream®, LabQuest Mini, or Go!Link®) 
 

TIP! If a sensor is connected via USB when Graphical Analysis is launched,  Sensor Data 

Collection is automatically selected, and the New Experiment box is not shown. 

Data Sharing 

Click or tap  Data Sharing to set up Graphical Analysis to receive wirelessly streamed sensor 

data from a Data Sharing source. Data Sharing sources can be any of the following: 

• LabQuest 2 

• LabQuest 3 

• A computer running Logger Pro® 3 software 

• Graphical Analysis Pro* 
 
*
 The Graphical Analysis Pro features must be unlocked to use this feature. 
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Manual Entry 

Click or tap  Manual Entry to initiate an experiment in which you manually enter data into a 

data table. You can use Graphical Analysis to analyze non-sensor data that you collect, find in a 

textbook, or find on the internet. 

Other Options 

Open Saved Files 

Click or tap  to open saved Graphical Analysis files (.gambl or .ambl) or 

comma separated value (.csv) files. 

Sample Data 

Choose Sample Data to access sample data files for Graphical Analysis. Sample data files 

include data for Boyle’s Law, Ball Toss, Plant Transpiration, and Periodic Trends. 

When the Graphical Analysis Pro features are unlocked, click or tap  for 

access to additional experiment files. For information on unlocking the subscription-based 

Graphical Analysis Pro features, see Unlocking Graphical Analysis Pro Features in Chapter 8. 

Modifying the Presentation Settings 

Click or tap Other Options, , on the top 

toolbar and choose Presentation to modify the 

presentation options. From the Presentation box, 

you can toggle between light and dark mode and 

set the Scale Factor used in Graphical Analysis. 

 

You can view Graphical Analysis in light mode 

or dark mode as desired. Click or tap Toggle 

Dark Mode, , to change the display to dark 

mode. 

Click or tap Toggle Light Mode, , to change 

the display back to Light Mode. 

TIP! If your device has a dark mode setting, 

Graphical Analysis uses that setting to determine 

which mode is displayed by default.  
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Use the slider to change the font scale factor used 

in Graphical Analysis. 

TIP! Reduce the Scale Factor when viewing 

multiple graphs to see more detail on each graph. 

 

Unlocking the Graphical Analysis Pro Features 

For information on unlocking the subscription-based Graphical Analysis Pro features, see 

Unlocking Graphical Analysis Pro Features in Chapter 8. 

 

III. Quick Start to Sensor Data Collection and Analysis 

Follow these steps to quickly get started with basic sensor data collection and analysis.  

1. Launch Graphical Analysis app. 

 

2. Select  Sensor Data Collection and 

connect a sensor. The default collection rate 

for the sensor is automatically set. 

 For more information on how to connect a 

sensor, see Getting Sensors Connected to 

Graphical Analysis. 
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3. Click or tap . 

 TIP! During data collection the Collect 

button, , changes to . 

 

4. Click or tap  to manually stop data 

collection. 

 TIP! When collection ends or is stopped 

manually, the Stop button, , 

changes back to . 

 

5. Click or tap Zoom, , to scale the graph to 

fit the data. 

 TIP! You can also double-click or double-tap 

the graph to autoscale the graph to fit the 

data. 
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6. Click or tap the graph to examine a point of 

interest. The coordinates of the point are 

shown. 

 Click or tap a different point or drag the 

Examine line to further examine your data. 

 To remove the Examine line, click or tap 

Delete Examine Tool, , displayed next to 

the line. 

 TIP! When viewing multiple graphs, the 

Examine line shows on all graphs. 

 

7. Click-and-drag or touch-and-drag across the 

graph to select a region of data for analysis. 

The selected region becomes highlighted. 

• To modify a region, drag the edges of the 
region. 

• To remove a selection, click or tap Delete 

Selection, , displayed on the region. 

 

 TIP! To analyze all data, you do not need to 

select a region.  

8. To view Statistics, click or tap Graph Tools, 

, and choose View Statistics. Statistics 

information is displayed on the graph. 

To dismiss Statistics, click or tap Close, , 

on the details box. 
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9. To fit a curve to the data, click or tap Graph 

Tools, , choose Apply Curve Fit, then 

select the desired fit equation. A preview of 

the curve fit is displayed on the graph. 

 

 10. Click or tap  to display the curve fit 

equation and coefficients on the graph. 

To remove the curve fit, click or tap Close, 

, on the details box. 
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IV. Looking at the Graphical Analysis Tools 

 

 

Access the File menu to start a new experiment, 

open a saved experiment, save your work, or 

export graphs or data. 

 
Start and stop data collection. 

 
Unlock Graphical Analysis Pro features. 

 

Adjust the view to include one or more graphs, a 

data table, or sensor meters. When Graphical 

Analysis Pro features are unlocked, you can also 

add a video. 

 

Access Other Options to modify the font and 

button sizes, access the user manual, and see 

what is new in the current version. 

When this icon is shown next to a column or 

data set name, click or tap the icon to access 

menu options specific to columns or data sets. 
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Use the x- and y-axis labels to change what data 

are plotted on your graph. 

 

Customize the graph appearance by changing 

the default point symbol and/or the trace color. 

 

Access data analysis tools from the Graph Tools 

menu including curve fits, statistics, and integral 

tools. 

 

Scale your graph to zoom to all data or zoom to 

a selection of data. 

 

Set your data-collection mode and modify data-

collection parameters such as rate and duration. 

 

Access a sensor meter for changing units and 

sensor calibration. 

 

Access Sensor Setup to view which sensors are 

connected, connect to wireless sensors, and 

modify sensor channels (select Go Direct 

sensors). 
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Graphical Analysis Pro Tools 

 

 

Host a Data Sharing session to share your data 

with other Graphical Analysis Pro users via the 

internet. 

 

Access tools to replay a time-based data 

collection including syncing a video of the 

collection to your data. 

 

Control the replay of data collection and synced 

videos. 

 

Synchronize a video of a time-based data 

collection. 

 
Control the replay of a video. 

 

Use picture-in-picture format to unclutter the 

screen when videos are included. 

 
Remove video from the file. 

 

Fast Fourier Transform (FFT) analysis tools 

(not shown in above image) 
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V. Summarizing the Graphical Analysis Pro Features 

Below is a summary of the features available when you unlock the subscription-based Graphical 

Analysis Pro features. For instructions on how to unlock these features, see Unlocking Graphical 

Analysis Pro Features in Chapter 8. 

Sample Experiments 

Graphical Analysis Pro comes with over 

40 sample experiments that include both data and 

videos. Use these files with your students for pre-

experiment exercises, independent study, or post-

experiment enrichment. Experiments for middle 

school, biology, chemistry, and physics are 

included. 

TIP! You can use these files as-is or use them for 

inspiration to create your own files. 

 

Data Sharing 

You can use Graphical Analysis Pro as a data 

sharing source that streams sensor data to other 

devices running Graphical Analysis Pro. 

Use Graphical Analysis Pro to data share lecture 

demonstration data with your in-person class or 

with students studying remotely so they can 

independently analyze the data. 

TIP! This feature requires a live internet 

connection. 
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Replaying Data Collection 

You can choose to replay a time-based data 

collection while having control over the replay 

speed. 

TIP! Pair this feature with a video of a time-

based sensor data-collection experiment synced 

to your data for a powerful analysis tool. 

 

Adding Videos to Experiment Files 

Add videos to your experiment files to illustrate 

how the experiment was done. 

 

Syncing Video with Data Collection 

Sync a video of a time-based sensor data-

collection experiment for enhanced data analysis 

of your experiment. Replay the data collection to 

see how the action in the video correlates to the 

collected data. 
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Customized Curve Fits 

You can create new curve fit functions to use to 

analyze your Graphical Analysis Pro data. 

Here are some examples expressions: 

• Modified Linear 
A+B*x or slope*x+intercept 

• Modified Quadratic 
A(x–h)^2 + k or A(x–a)(x–b) 

• Base-10 Exponent 
A*10^(Bx+C)+D 

• Gaussian 
A*exp(–(x–B)^2/C^2)+D 

 

Custom Expression Calculated Columns 

Use mathematical functions to define custom 

expressions for your calculated columns in 

Graphical Analysis Pro. 

Available functions include the following: 

• Common math functions including square 
root, cube root, power, exponential, and 
logarithmic functions 

• Trigonometric functions including inverse 
and hyperbolic trigonometric functions 

• Number sense functions including absolute 
value, round, truncate, ceiling, floor, and 
modulo 

 

 
For a complete list of functions, see https://www.vernier.com/til/11314. 

FFT Analysis 

Apply an FFT to perform a Fast Fourier 

Transform (FFT) analysis of time-based data. 

The FFT bar graph displays the amplitudes of the 

frequencies of the sine wave components that 

make up the data. 

FFTs are commonly used to analyze the 

frequencies found in microphone data and can be 

used to identify electronic noise in non-

sinusoidal analog sensor data. 

 

https://www.vernier.com/til/11314
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CHAPTER 2—COLLECTING SENSOR DATA 

Launch Graphical Analysis to view the New 

Experiment box. 

TIP! If Graphical Analysis is already running, 

click or tap the File menu, , and 

choose New Experiment. You may be prompted to 

save or discard the current file. 

 

Click or tap  Sensor Data Collection to start a 

sensor data-collection experiment. This displays 

the Sensors box. 

TIP! If a sensor is connected via USB when 

Graphical Analysis is launched, Sensor Data 

Collection is automatically selected, and the New 

Experiment box does not display. If this happens, 

click or tap Sensor Setup, , to display the 

Sensors box. 
 

I. Getting Sensors Connected to Graphical Analysis 

Connecting Sensors via Bluetooth Wireless Technology 

Vernier Go Direct sensors can connect to Graphical Analysis using Bluetooth® wireless 

technology. The connection is one-to-one meaning that only one device (computer, Chromebook, 

smartphone, or tablet) can connect to that sensor at a time. 

1. Make sure your sensor is on. 

2. From the Sensors box, locate your sensor in 

the Discovered Wireless Devices list. The 

serial number, located on each sensor, 

represents the sensor name. 

3. Click or tap Connect to connect to your 

sensor. 
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NOTE: Older Vernier wireless sensors—Wireless Dynamics Sensor System (WDSS), 

Go Wireless Temp, Go Wireless pH, and Go Wireless Electrode Amplifier—are not supported in 

Vernier Graphical Analysis. These sensors will not appear under Discovered Wireless Devices. 

Tools for Finding and Connecting Your Sensor 

Using Proximity Connect 

You can use Proximity Connect to connect to the 

sensor with the strongest signal. This is typically 

the sensor closest to your computing device. 

Make sure your sensor is powered on and located 

near your computing device. Click or tap 

 to initiate the automatic 

connection. 

 

The sensor with the strongest signal is identified 

and connected automatically. 

TIP! Since many factors can affect signal 

strength, Proximity Connect may not always 

connect to the sensor closest to your computing 

device. If you have trouble connecting to the 

correct sensor, manually select your sensor from 

the list. 

 

When using Proximity Connect, the app connects 

to one sensor at a time. You can repeat the 

process to connect additional sensors as needed. 
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Using Device List Filter 

Use the device filter to help locate your sensor in 

the list. 

You can enter part of the sensor order code to 

look for all sensors of a certain type (e.g., type 

“cart” to find all sensor carts). 

 

You can enter part of the serial number found on 

the sensor label to show only sensors with that 

particular character or characters (e.g., type 

“100” to find all of the sensors with 100 in their 

serial number). 

 

Setting Up Sensors with Multiple Sensor Channels 

Some Go Direct sensors have multiple sensor 

channels. These sensors have default 

configurations that do not typically use all 

available sensor channels. 

These sensors can be identified by the Sensor 

Channels details displayed under its listing in the 

Connected Devices list. 
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1.  Click or tap Sensor Channels to modify the 

default sensor configuration. 

2.  Modify the sensor channel configuration as 

needed for your experiment. 

 TIP! For some sensors, selecting a new 

sensor channel automatically deselects the 

previously selected sensor channel. This 

indicates that those sensor channels cannot 

be used at the same time. 

 

3.  Once you have connected to and configured 

the sensor channels as desired, click or tap 

 to continue with your experiment. 

TIP! If needed, you can click or tap Sensor 

Setup, , to return to the Sensors box, where 

you can add or remove wireless sensors and 

modify the sensor channel configuration of a 

connected sensor. 

 

Connecting Sensors via USB (Computers and Chromebooks only) 

USB sensors, such as Go!Temp, Go! Motion, and our Go Direct sensors can connect to a 

computer or Chromebook for data collection with Graphical Analysis. You can also connect to 

Vernier wired LabQuest sensors when using a USB sensor interface such as a Go!Link, 

LabQuest Mini, LabQuest Stream, original LabQuest, LabQuest 2, or LabQuest 3. 

1. Launch Graphical Analysis on your computer 

or Chromebook to view the New Experiment 

box. 

 TIP! If Graphical Analysis is already 

running, click or tap the File menu, 
, and choose New Experiment. 

You may be prompted to save or discard the 

current file. 
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2. Click or tap  Sensor Data Collection to 

start a sensor data-collection experiment. This 

displays the Sensors box. 

 

3. Connect the sensor to your computer or 

Chromebook™ notebook. (If you are using 

an interface with a wired sensor, connect the 

sensor to the interface, then connect the 

interface to your computer or Chromebook.) 

 TIP! If a sensor is connected via USB when 

Graphical Analysis is launched, Sensor Data 

Collection is automatically selected and the 

New Experiment box does not display. If this 

happens, click or tap Sensor Setup, , to 

display the Sensors box. 

 

4. If your sensor is a Go Direct sensor with 

multiple sensors channels, set up the sensor 

channels as described in Setting Up Sensors 

with Multiple Sensor Channels. 
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5. Once you have connected to the sensor and 

configured the sensor channels as desired, 

click or tap  to continue with your 

experiment. 

Note: Older wired sensors that require an adapter 

to connect to an interface and/or do not 

automatically ID when connected are not 

supported in Graphical Analysis. 

 

Connecting Sensors via Wireless Interface (iOS, iPadOS, and Android Only) 

You can connect Vernier wired LabQuest® sensors to an iOS, iPadOS, or Android device using a 

LabQuest Stream® interface connected to your device via Bluetooth® wireless technology. This 

functionality is not supported on a computer or Chromebook as LabQuest Stream can only 

connect to those platforms via USB connection. 

1. Launch Graphical Analysis on your device to 

view the New Experiment box. 

 TIP! If Graphical Analysis is already 

running, click or tap the File menu, 
, and choose New Experiment. 

You may be prompted to save or discard the 

current file. 

 

2. Tap  Sensor Data Collection to start a 

sensor data-collection experiment. This 

displays the Sensors box. 
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3. Connect the sensor to LabQuest Stream and 

power on the interface. 

iOS and iPadOS Devices 

 Tap . 

 TIP! It can take 30 seconds or more before 

the discovered LabQuest Stream devices are 

show in the list. 

 

Android 

 Tap the LabQuest Stream tab. 

 TIP! You can filter your list of discovered 

LabQuest Stream units if needed. 

 

4. From the list of discovered devices, select 

your LabQuest Stream. 

 The LabQuest Stream serial number is used 

as the unique identifier for that interface. 

This number is found on the back label of 

the LabQuest Stream unit. 
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5. Tap  to continue with your 

experiment. 

Note: Older wired sensors that require an 

adapter to connect to an interface and/or do not 

automatically ID when connected are not 

supported in Graphical Analysis. 

 

II. Configuring Sensors 

A digital sensor meter (e.g., ) for each connected sensor is shown on the bottom bar of 

Graphical Analysis. The value shown is the current reading of a sensor updated about twice a 

second. These readings are based on the sensor calibration and can be configured as described 

below. 

Click or tap a sensor meter, , to access 

tools that modify the sensor readings. The tools 

include options to calibrate, zero, reverse, and 

change units. Which tools are available depend 

on the connected sensor as not all options are 

appropriate for all sensors. 

TIP! These tools can also be accessed from the 

meters displayed using View Options, . 

 

Calibrate 

Most sensors use a custom factory calibration 

stored on the sensor. However, some sensors 

require calibration. Choose Calibrate to initiate 

sensor calibration. Not all sensors can be 

calibrated. 

TIP! Detailed calibration instructions are 

provided in sensor user manuals available 

online at www.vernier.com/manuals. 

 

http://www.vernier.com/manuals
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Zero 

Choose Zero to set the current sensor reading to 

zero. This defines an offset that is applied to all 

future readings. Not all sensors can be zeroed. 

TIP! Zeroing does not affect data that have 

already been collected. 

 

Reverse 

Some sensors read both positive and negative 

values. For example, Vernier force sensors read 

positive values when pulled and negative values 

when compressed. 

Turn on Reverse to swap the sign of the readings 

with respect to the default behavior. Not all 

sensors can be reversed. 

TIP! Previously collected data are not changed 

when Reverse is toggled. 
 

Units 

Some sensors have the option to display data in 

different units. Choose the desired unit of 

measure from the Units dropdown menu. Not all 

sensors have additional units that can be selected. 

TIP! Choosing a new unit changes all existing 

and subsequent data for that sensor. 
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III. Modifying the Data-Collection Settings 

Click or tap Mode, , to open Data Collection Settings. The 

parameters listed depend on the connected sensors and the mode selected. 

Mode: Time Based 

Time-based data collection is the default data-

collection mode for most sensors. In this mode, 

sensor readings are recorded at regular time 

intervals. 

Parameters for this mode include Time Units, 

Rate and Interval, and Start and End Collection. 

The total number of samples to be collected 

based on these parameters is displayed. 

 

Time Units 

The default time unit is seconds. Additional time 

unit options include milliseconds, minutes, and 

hours. 

Time unit changes are applied to the rate, 

interval, and duration values as indicated by their 

units. 

 

Rate and Interval 

Rate refers to the number of data points collected 

each time period. Interval refers to the time 

period between successive data points. Changing 

one of these values automatically changes the 

other, as they are reciprocals of each other. 

TIP! When using multiple sensors, the fastest 

default collection rate for the connected sensors 

is used as the default rate. 
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When the Rate × End Collection Duration 

exceeds 15,000 points, a warning is displayed 

indicating performance of the app may be 

impacted. 

 

Start Collection 

The two options for starting data collection are Manually and On a Triggering Event. 

Manually 

This is the default option that requires you to 

click or tap  to start data collection. 

 

On a Triggering Event 

When On a Triggering Event is selected, 

Graphical Analysis waits for a trigger threshold 

condition to be met before recording data. 

Choose the sensor used for the trigger and set the 

trigger threshold value. You can trigger as the 

sensor reading increases or decreases past the 

threshold value. 
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Click or tap  to start monitoring for the 

trigger. When the trigger condition has been met, 

data begin plotting on the graph. 

 

You can choose to collect data points before the 

trigger condition is met. The time values for 

those points will be negative. Choosing this 

option will increase the overall experiment 

duration. 

 

End Collection 

There are two options for ending data collection—After Fixed Duration or Manually. 

After Fixed Duration 

Ending after a fixed duration is the default 

option. Data collection continues until the 

duration time is met. 

The default duration is determined by the 

connected sensor(s) but can be modified. When 

more than one sensor is connected, the default 

duration is the shortest duration of the connected 

sensors. 

TIP! You can click or tap  to end 

collection early if needed. 

 

Manually 

This option requires you to click or tap  to stop data collection. 
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Mode: Event Based 

Sometimes experiments use an attribute other 

than time as the independent variable. For 

example, in a Boyle’s law experiment, you 

investigate pressure as a function of volume of a 

gas. For these situations, event-based data 

collection is used. 

Parameters for this mode include Event Mode 

and 10-second averaging. You can also rename 

and provide units for the “Event” column. 

 

The default view for event-based data collection 

includes a graph and a data table. 

For event-based data collection, a  

button is displayed next to the  button. 

TIP! In event-based collection, time information 

is not recorded. 

 

Event Mode: Events with Entry 

This event mode provides a prompt to enter the 

independent “Event” value each time you keep a 

data point. 

TIP! During event-based data collection, 

sensors are sampled 10 times each second while 

data collection is active. 
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Event Mode: Selected Events 

This event mode does not prompt for the 

“Event” value when you click or tap . 

Instead, the associated row number (1, 2, 3, ...) is 

automatically recorded as the “Event” value for 

each new data point. 

 

Average over 10 seconds 

This option reports the average sensor reading 

over a 10-second collection. Sensors are sampled 

at 10 samples per second. 

TIP! Average over 10 seconds can be used with 

either Events with Entry or Selected Events event 

modes. 

 

Mode: Drop Counting 

Drop Counting mode is the default mode 

whenever a Drop Counter is connected. When 

using this mode, data points are recorded every 

time a drop is detected by the Drop Counter. 

TIP! While you can manually set the mode to 

Drop Counting for any sensor configuration, 

data can only be collected when there is a Drop 

Counter and at least one other sensor. 
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Mode: Photogate Timing 

Photogate Timing mode is the default mode whenever a wired (BTD) Photogate, a Go Direct 

Photogate with only Gate State channels selected, or a Projectile Launcher is connected. When 

using this mode, the time a gate is blocked or unblocked is recorded as an object passes through 

the gate. The times are used to determine attributes of the motion of the object. Which attributes 

are calculated depend on the measurement type. 
 
Speed Through Gate 

This default option for two photogates reports the 

speed of an object as it passes between the gates. 

Use object / flag width 

For a single photogate, the speed of an object 

passing through the gate is determined by 

dividing the width of the object that blocks the 

gate (the flag) by the time duration the object 

(flag) is blocking the gate. 
 

Use gate separation 

For two individual photogates or a double 

photogate, the speed of an object passing through 

the gate is determined by dividing the distance 

between the gates by the time duration between 

the blocked-events as the object passes the two 

gates. 

TIP! You can find the average speed of an object 

as it passes between any pair of gates as long as 

the gate separation is known.  

Linear Motion (distance, velocity, acceleration) 

This is the default photogate option when only 

one photogate is used. 

This option reports the linear position of an 

object at times associated with the blocked times 

of multiple, equal-spaced flags on an object. The 

first blocked event determines the zero position. 

The position vs. time data is used to calculate 

velocity and acceleration data. 
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Object 

Photogate accessories sold by Vernier can be 

selected from the Object dropdown list. These 

objects have a predefined spacing and number of 

flags that are shown when the object is selected. 

 

For objects not made by Vernier, select 

Other / User Defined and manually enter the 

Spacing and Number of flags. 

TIP! If the object is a wheel with multiple 

spokes, Spacing is the circumference of the wheel 

divided by the number of spokes, and Number of 

flags equals the number of spokes. 

 

End Data Collection 

Select After Set Number of Flags to 

automatically stop collection after the object has 

completely passed through all gates. 

Select Manually to continuously collect data 

until you click or tap . 
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Angular Motion (distance, velocity, acceleration) 

This option reports the angular position of an object at times associated with the blocked times of 

multiple, equal-spaced spokes on a wheel. The first blocked event determines the zero position. 

The angular position vs. time data is used to calculate angular velocity and angular acceleration 

data. 

Angle Units 

Select the desired angle unit for your 

experiment. The default unit is radians. 

 

TIP! 2π radians = 1 revolution = 360° 

 

Timer or Period 

This option includes two different time measurements: Time between gates and Pendulum period. 

Time between gates 

The time between blocked events from two 

gates is reported as Pulse Time. Measurements 

are displayed only when Gate 2 is blocked after 

Gate 1. 

TIP! You can also use this option to measure 

times between successive blocks of a single 

photogate. 

 

Pendulum Period 

The time between every second blocked event 

for a single gate is reported as Period. 

TIP! The pendulum bob must completely pass 

through the gate twice for a period 

measurement to be recorded. 
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Projectile Launcher 

This option is the default option when using a Projectile Launcher. The photogates built into the 

projectile launcher are used to determine the launch speed of the projectile. 

Use Gate Separation 

This option uses the distance between the two 

launch photogates to determine the launch 

speed of the projectile. The default distance is 

0.05 m. 

 

Use Projectile Diameter 

This option uses the diameter of the projectile to 

determine the launch speed as the projectile 

passes through the first launch gate. The default 

diameter is 0.017247 m or 11/16 inches. 

TIP! You can use two wired [BTD] photogates 

with this mode as long as the photogates are 

daisy-chained together, reporting a single 

gate-state column in the data table. 

 

Use Time of Flight Pad 

The Time of Flight Pad accessory is required 

when using this option. 

This option reports Time of Flight as the time 

between blocking the first launch gate and 

striking the Time of Flight Pad. 

 

TIP! You can use the Time of Flight Pad with 

either Launch Speed configuration. 
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TIP! You can click or tap Info, , to access 

Photogate setup information for any photogate 

timing measurement. 

 

IV. Setting Up the Display (Graph, Data Table, and Meters) 

Graphical Analysis automatically displays a view based on the experiment type, data-collection 

mode, and connected sensors. You can use this recommended view or modify the view using the 

options provided. 

Click or tap View Options, , then modify the 

options as desired. 

TIP! When the Graphical Analysis Pro features 

are unlocked, you can also display a video. See 

Adding a Video to a Graphical Analysis Pro 

Data File in Chapter 8. 

 

Using Only a Single Display Element 

For a full-screen view of a Graph, Data Table, or Meter use only one of the options. The graph 

element can show one, two, or three graphs. 

1 Graph 

This is the default view of time-based data 

collection with a single sensor. 

This view is also used when there are multiple 

sensors all using the same unit of measure. 
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2 Graphs 

This is the default view of time-based data 

collection with two (or more) sensors when the 

sensors have two different units of measure. 

This is also the default view when using some 

motion detectors where the first graph plots 

position vs. time and the second graph plots 

velocity vs. time. 

 

3 Graphs 

This is the default view of time-based data 

collection with three or more sensors when the 

sensors have three different units of measure. 

 

Table 

This view shows the data table. This view is not 

displayed by default. 
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Meter 

This view shows large sensor meters for the 

connected sensors. This view is not displayed by 

default. 

 

Using Two Display Elements 

You can choose to show two elements such as a graph and data table. The display is split 

vertically to show the two elements side-by-side. The split can be adjusted by dragging the resize 

handle, , located on the separating line. 

Graph and Data Table 

This is the default view for event-based, drop 

counting, photogate timing, and manual entry 

experiments. 

The data table is always displayed to the right of 

the graph. The graph region can display one, two, 

or three graphs as needed. 

 

Graph and Meter 

Sensor meters are displayed to the right of the 

graph. The graph region can display one, two, or 

three graphs as needed. This view is not 

displayed by default. 
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Data Table and Meter 

Sensor meters are displayed to the right of the 

data table. This view is not displayed by default. 

 

Using All Three Display Elements 

Graph, Data Table, and Meter 

When using all three elements, the graph is 

shown on the left and can display one, two, or 

three graphs. 

The right region is split horizontally to show the 

data table above the sensor meter(s). The various 

splits can be adjusted by dragging the resize 

handles, , located on the 

separating lines. 
 

V. Collecting Data 

Time-Based Data Collection 

Click or tap  to start data collection. 

TIP! You can use the space bar on a computer 

or Chromebook keyboard to start and stop data 

collection while Graphical Analysis has focus. 
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While collecting data, some toolbar buttons, such 

as the mode button and sensor meters, are no 

longer accessible. 

 

Click or tap  to stop data collection, or 

wait until data collection ends automatically. 

 

Click or tap Zoom, , to scale the graph to fit 

all data points. 

The left and right boundaries match the left and 

right extremes of your data. The top and bottom 

boundaries automatically adjust to show all data. 
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Collecting Multiple Data Sets 

To collect another data set, click or tap  

again. Your original data set is saved, and the 

new data set is displayed on the graph. 

TIP! To plot your original data set, click or tap 

the y-axis label, , and turn on 

columns from the desired data set. 

 

Event Based Data Collection 

Click or tap  to start data collection. 

This enables the  button. 

 

Click or tap  when you are ready to 

record a data point. 

When Events with Entry is selected, you are 

prompted for the “Event” value. 

TIP! The sensor reading at the time you select 

 is shown in the Keep Point box. 

Changes to the sensor value while the box is 

shown are ignored until the box is dismissed. 
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Enter the corresponding “Event” value for this 

data point, then click or tap  to 

record the entry in the data table. 

The point is automatically plotted on the graph. 

 

Continue as needed until you have collected all 

of your data points. 

TIP! The graph scales automatically as you 

 each point to ensure all data points are 

shown on the graph. 

Click or tap  to stop data collection and 

continue with data analysis. 

 

Collect Multiple Data Sets 

To collect another data set, click or tap  

again. For event-based data collection, you can 

append new data to your existing data set or start 

a new data set. 

TIP! To plot your original data set, click or tap 

the y-axis label, , and turn on 

columns from the desired data set. 
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VI. Adding a Prediction 

The Add Prediction tool is a free-hand sketching tool for adding predictions to a graph. 

TIP! Requiring students to draw predictions prior to data collection has been shown to increase 

student understanding of science concepts. 

 

Click or tap Graph Tools, , and choose Add 

Prediction to access the tool. 

If you are viewing multiple graphs or a graph 

with another display element such as a meter or 

data table, the graph to which you are adding the 

prediction expands to full screen while the Add 

Prediction tool is active. 

 

Click-and-drag or touch-and-drag across the 

graph to sketch your prediction. 

Name the prediction if desired, then click or tap 

 to add the prediction to your graph. 

TIP! If you do not like your first prediction 

attempt, drag across the graph again to remove 

the first, and draw a new prediction.  

 

Collect data to compare your predication with 

real data. 
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To hide a prediction from the graph, click or tap 

the y-axis label and turn off the prediction. 

 

To delete a prediction, click or tap the y-axis 

label, then click or tap Other Options, , next 

to the prediction, and choose Delete Prediction. 

 

VII. Graph Matching with Motion Sensors 

Click or tap Graph Tools, , and choose Add 

Graph Match to have a position or velocity target 

drawn on the graph. 

Add Graph Match is only available when a 

Motion Detector, Motion Encoder, or Sensor 

Cart is connected. 

TIP! When more than one graph is displayed, 

you can choose Add Graph Match from any 

graph to get started.  
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Choose a Position or Velocity target to match. 

TIP! When working with students that have 

never done a graph match, start with a position 

match. 

 

Position Match 

A Position Match contains three linear segments. 

TIP! The Position Target is always displayed in 

a single graph view regardless of the display 

settings when Graph Match is selected. 

 

Start data collection and move so your detected 

motion matches the displayed graph. 

TIP! You can repeat data collection as often as 

desired. To get a different match, select Graph 

Match Position again. 
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Velocity Match 

A Velocity match contains three horizontal 

(constant velocity) segments. 

To get a different match, select Graph Match 

Velocity again. 

TIP! The Velocity Target always displays in a 

single graph view regardless of the display 

settings when Graph Match is selected. 

 

To hide a Position or Velocity Target from the 

graph, click or tap the y-axis label and turn off 

the Graph Match target. 

 

To delete a Graph Match target, click or tap the 

y-axis label, then click or tap Other Options, , 

next to the target, and choose Delete Graph 

Match. 

 

VIII. Analyzing Your Data 

See Chapter 6–Analyzing Your Data 
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CHAPTER 3—CONNECTING TO A DATA SHARING SOURCE 

Graphical Analysis can receive wirelessly streamed sensor data from a Data Sharing source such 

as LabQuest 2, LabQuest 3, or a computer running our Logger Pro 3 software. 

When the Graphical Analysis Pro features are unlocked, you can also connect to a Graphical 

Analysis Pro Data Sharing Source. 

I. Data Sharing with a LabQuest or Logger Pro Data Sharing Source 

How LabQuest or Logger Pro Data Sharing Works 

• Set up an experiment with Vernier sensors and LabQuest 2, LabQuest 3, or Logger Pro 3 

software configured to be a data sharing source. For more information, see 

https://www.vernier.com/til/2675 

• Use Graphical Analysis to wirelessly connect to the Data Sharing Source using Wi-Fi. Both 

devices must be on the same Wi-Fi network; however, the Wi-Fi network does not require 

internet connectivity. 

• Data collected on the host device are shared with the connected devices. The data can be 

streamed live during data collection or transferred in full after data collection is complete. 

• Each recipient of the data can perform an individual analysis of the shared data on their 

device. Data analysis done on the host or any connected device is not shared with the other 

devices. 

 

Connecting to a LabQuest or Logger Pro Data Sharing Source 

1. Connect your computer, Chromebook, or mobile device to the same Wi-Fi network used by 

the Data Sharing source (LabQuest 2, LabQuest 3, or a computer running Logger Pro 3). 

2. Launch Graphical Analysis. 

 

https://www.vernier.com/til/2675
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3. Click or tap  Data Sharing. Discovered 

Devices are listed automatically. 

TIP! If your device is not listed, you can 

connect to it by choosing Specify Source and 

manually entering the data sharing source’s 

IP address. 

 

 If you are using Graphical Analysis Pro, you 

must select the Local option to connect to a 

LabQuest or Logger Pro Data Sharing source. 

 

4. Click or tap the name of the Data Sharing 

source (or enter the data sharing source IP 

address, then click or tap ) to 

connect to the source. 

 TIP! Bottom toolbar buttons are not active 

during a Data Sharing activity. Data 

collection and sensor settings are modified on 

the Data Sharing source. 
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II. Data Sharing with a Graphical Analysis Pro Data Sharing Source 

How Graphical Analysis Pro Data Sharing Works 

• Set up a sensor data-collection experiment using Vernier sensors and Graphical Analysis 

with the Graphical Analysis Pro features unlocked. 

• Configure Graphical Analysis Pro on the host device to Data Share and share the data sharing 

ID with everyone that needs it. For more information, see Setting up Graphical Analysis Pro 

as the Data Sharing Host 

• Participants use the data sharing ID to join the session on their devices that also have the 

Graphical Analysis Pro features unlocked. All devices need a live internet connection to 

make this possible. 

• Data collected on the host device are shared with the connected devices. The data can be 

streamed live during data collection or transferred in full after data collection is complete. 

• Each recipient of the data can perform an individual analysis of the shared data on their 

device. Data analysis done on the host or any connected device is not shared with the other 

devices. 

Connecting to a Graphical Analysis Pro Data Sharing Source 

1. Make sure your device has a live internet 

connection, then launch Graphical Analysis. 

 TIP! You must unlock the Graphical Analysis 

Pro features on your device in order to 

connect to a device hosting a Graphical 

Analysis Pro data sharing session. 

 

2. Click or tap  Data Sharing to connect to a 

Data Sharing source. Enter the six-digit Data 

Sharing ID code provided to you by the Data 

Sharing host. 

 TIP! The Online option is only used with 

Graphical Analysis Pro data sharing sources. 

Use the Local option when connecting to a 

LabQuest 2, LabQuest 3, or Logger Pro 3 

data sharing source. 
 



Vernier Graphical Analysis™ and Graphical Analysis Pro —User Manual 

 

50 Vernier Software & Technology 

3. Click or tap  to connect to the data 

sharing source. You can verify that you are 

connected to the correct source by checking 

the source ID displayed in the lower left 

corner of the screen. 

 TIP! If the data sharing host’s file includes a 

video or contains data analysis such as a 

curve fit, your file will not include those items. 

Only the host’s data is shared with the 

connected devices.  

III. Using Graphical Analysis as a Data Sharing Client 

When you are connected to a data sharing host, 

the host device sends graph configuration 

information and any collected data. As the host 

collects additional data, those data are also 

plotted on the connected devices as long as you 

have not interacted with the graph setup in any 

way. 

Any data analysis done on the host device is not 

transferred to your device as the intention is that 

you perform your own data analysis.  

Changing the displayed view, rescaling the graph, examining a data point, or starting any data 

analysis can cause your instance of the shared data to stop automatic graph updates. Your device 

continues to get the additional data, they just no longer automatically display on your graph. 

To return to updating automatically as the host device updates, click or tap the File menu, 

, and choose New Experiment. Follow the steps for connection to the host device 

again. 
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If the host starts a new data-collection experiment 

or opens a new file while data sharing, you are 

prompted to join the new experiment. 

Click or tap  to remain 

connected to the data sharing host. 

TIP! If you need to save your work from the 

previous experiment before continuing to the next 

experiment, click or tap Disconnect, save the file, 

then reconnect as you did before. 
 

IV. Analyzing Your Data 

See Chapter 6–Analyzing Your Data 
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CHAPTER 4—MANUALLY ENTERING DATA 

Click or tap  Manual Entry to initiate an 

experiment where you manually enter data into a 

data table. You can use Graphical Analysis to 

analyze data you collect without sensors as well 

as data found in textbooks or on the internet. 

 

I. Setting up Columns 

Click or tap Column Options, , next to a 

column name in the data table, or you can access 

Column Options from the y-axis Plot Manager. 

Choose Column Options to name the column, 

define the units, and select the displayed 

precision. 

 

Click or tap the Symbol icon (e.g., ), to 

modify the Point Colors and Point Symbols used 

when the column is plotted on a graph. 

Click or tap  to save the changes. 
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Adding Additional Manual Columns 

Click or tap Column Options, , next to a 

column name, and choose Add Manual Column 

to create a new manual entry column. The new 

column is added to the right of the column used 

to access the column tools. 

You can modify the column name, add units, and 

adjust the display precision of the new column as 

desired. 

Click or tap  to save the changes.  

Adding a Calculated Column 

Click or tap Column Options, , next to a 

column name, and choose Add Calculated 

Column to create a new column with values that 

are based on other columns through a 

mathematical formula. 

You can modify the column name, add units, and 

adjust the display precision of the new column as 

desired. 

 

Click or tap  to view your 

expression options. Select the desired expression 

to use for your calculated column. 

NOTE: A, B, and C represent constants. X, Y, 

and Z represent data columns from your data 

table. 

TIP! When the Graphical Analysis Pro features 

are unlocked, you can use user-defined 

expressions in your calculated columns. See 

Custom-Expression Calculated Columns in 

Chapter 8. 
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The column from which you accessed the column 

tools is used in the calculated column expression 

by default. Adjust the columns and parameters as 

desired. 

Click or tap  to save the changes. The 

new calculated column appears to the right of the 

column used to access the Column Options. 

TIP! To edit a calculated column once it has 

been created, click or tap Column Options, , 

next to the column name in the data table or y-

axis Plot Manager and select Column Options. 

 

Deleting a Column 

Click or tap Column Options, , next to a 

column name in the data table or y-axis Plot 

Manager, and choose Delete Column to remove 

Manual or Calculated Columns. 

Click or tap  to confirm the deletion. 

Deleting a column cannot be undone. 

TIP! The original X and Y data columns cannot 

be deleted. 
 

Renaming a Data Set 

Click or tap Data Set Options, , next to a data 

set name in the data table, and choose Rename 

Data Set to change the default data set name. 

Click or tap  to save the changes. 
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Adding Additional Data Sets 

Click or tap Data Set Options, , next to a data 

set name, and choose Add New Data Set to add 

an additional data set. 

The new data set has the same columns and 

configurations as the original data set and is 

added to the data table after the last data set. 

TIP! The option to add additional data sets is 

only available for a Manual Entry experiment. 

 

Deleting a Data Set 

Click or tap Data Set Options, , next to a data 

set name, and choose Delete Data Set to remove 

a data set. 

Click or tap  to confirm the deletion. 

Deleting a data set cannot be undone. 

 

II. Entering Data in Your Data Table 

Manual Data Entry 

Double-click or double-tap a data table cell to add or edit the data. 

Using the Cut, Copy, and Paste Tools 

You can copy data between your data table and the system clipboard on your computing device. 

Copy to the Clipboard 

• Windows: Right-click and select Copy (or Ctrl-C) 

• macOS: Command-C (-C) 

• Chromebook: Alt-click and select Copy (or Ctrl-C) 

• iOS, iPadOS, and Android (and other touch-screen devices): Long-touch within the 

selection and select Copy 
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Cut (and Copy) to the Clipboard 

• Windows: Right-click and select Cut (or Ctrl-X) 

• macOS: Command-X (-X) 

• Chromebook: Alt-click and select Cut (or Ctrl-X) 

• iOS, iPadOS, and Android (and other touch-screen devices): Long-touch within the 

selection and select Cut 
 

Paste from the Clipboard 

• Windows: Right-click and select Paste (or Ctrl-V) 

• macOS: Command-V (-V) 

• Chromebook: Alt-click and select Paste (or Ctrl-V) 

• iOS, iPadOS, and Android (and other touch screen devices): Long-touch the desired 

location and select Paste 
 
TIP! When using Paste to copy data from multiple columns, you must first add the appropriate 

number of manual columns to your data table. 

Selecting Cells in your Data Table 

• To select a single cell, single-click or tap the cell. 

• To select a range of cells, click-and-drag or touch-and-drag across the cells. 

• To select a single row, click or tap a row number. 

• To select a range of rows, click-and-drag or touch-and-drag across the row numbers. 

• To select a single column, click or tap a column header. 

• To select a range of columns, click-and-drag or touch-and-drag across the column 

headers. 

• To select a single data set, click or tap a data set header. 

• To select a range of data sets, click-and-drag or touch-and-drag across the data set 

headers. 

III. Setting Up the Display (Graph, Data Table, and Meters) 

Graphical Analysis automatically displays a 

graph and a data table in manual entry mode. 

Click or tap View Options, , then modify the 

options as desired. For more information, see 

Setting Up the Display (Graph, Data Table, and 

Meters) in Chapter 2. 

 

IV. Analyzing Your Data 

See Chapter 6–Analyzing Your Data. 
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CHAPTER 5—CUSTOMIZING THE GRAPHS 

I. Changing What is Plotted on the Graph 

Click or tap the y-axis label, , to change 

the data that are plotted on the graph. 

Click or tap a column name to add or remove the 

column data from the graph. 

TIP! Column data for all selected columns are 

shown on the graph. 

 

Click or tap a data set name to show or hide the 

selected column data for a specific data set. 

TIP! Use Expand All Data Sets and Collapse All 

Data Sets to quickly show or hide the columns 

from every data set. 

TIP! Use the Plot All and Hide All options to 

quickly add or remove all data columns from the 

graph for a specific data set. 

 

Click or tap the x-axis label, , to select 

the desired independent variable for your graph. 

Only one column can be used as the independent 

variable for any graph. 

TIP! You cannot plot a column vs. itself. If the 

column you select for the independent variable is 

already plotted on the vertical axis (y-axis), that 

column is removed from the graph. 
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II. Adjusting the Graph Style 

Changing the Point Symbol and Trace Color 

Click or tap the y-axis label, , to access 

the Plot Manager.  

Click or tap Point Symbols, , and choose a 

different symbol or trace color. 

TIP! Changes to Point Colors and Point 

Symbols apply only to the column that was 

selected. The change is applied to any graph that 

is plotting that column’s data. 
 

Click or tap  for more color options. 

TIP! Custom colors can be defined using RGB, 

HSL, or Hex values.  Click or tap the color 

values (e.g.,  ) to 

change the input option. 

 

Modifying the Graph Appearance 

Click or tap Graph Tools, , and choose Edit 

Graph Options to access the graph configuration 

tools. 

Adjust the appearance as desired. Click or tap 

Close, , to dismiss Graph Options. 

TIP! When displaying multiple graphs, Graph 

Options changes only apply to the graph from 

which the tool is accessed. The changes are not 

applied to the other graphs.  
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Points 

Choose Points to show data as unconnected 

points. 

This is the default option for manual 

experiments and sensor experiments that use 

event-based, drop counting, and photogate 

timing modes. 

TIP! Point symbols can be changed from the 

y-axis Plot Manager or Column Options.  

Lines 

Choose Lines to show linear segments drawn 

between the data points. Individual point 

symbols are not shown. 

This is the default option for time-based sensor 

experiments. 

 

Both—Points and Lines 

Choose Both to show data as dots connected by 

linear segments. This option is not displayed by 

default. 
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III. Scaling the Graph 

Zoom to a Selected Region 

To scale the graph to a specific section of your 

data, click-and-drag or touch-and-drag across the 

graph to select the desired region. 

TIP! You can click-and-drag or touch-and-drag 

the boundaries of a selected region to adjust the 

region as needed.  

 

When a region is selected, click or tap Zoom to 

Selection, , to scale the graph to fit the 

selection. 

The left and right boundaries match the selected 

region. The top and bottom boundaries 

automatically adjust to show all data within the 

region. 

 

You can click or tap Zoom to all Data, , to 

rescale the graph to fit all data. 
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Panning the Graph 

Click-and-drag or touch-and-drag near one of the 

axes to move (pan) the graph without changing 

the scaling. Starting near the horizontal axis  

(x-axis) pans the graph horizontally. Starting 

near the vertical axis (y-axis) pans the graph 

vertically. 

TIP! Touch-screen devices can use a two-finger 

pinch gesture to pan and rescale the graph. 

 

Manual Scaling 

Click or tap Graph Tools, , and choose Edit 

Graph Options to access the graph configuration 

tools. 

Manually configure the x-axis and y-axis ranges 

to adjust the scaling as desired. Click or tap 

Close, , to dismiss Graph Options. 

Scaling—Automatic 

This default option allows the graph to scale 

larger during data collection to ensure all data 

points are visible. 
 

TIP! Manually entered values are not respected when the scaling option is set to Automatic. 

Scaling—Always Show 0 

This option automatically scales the graph to 

include 0 for that axis. This setting does not 

change the automatic scaling of the graph larger, 

but it is respected when you manually rescale the 

graph using Zoom to all Data, . 

Scaling—Manual 

This option disables the automatic behavior 

related to scaling the graph larger during 

collection but is not respected when you 

manually rescale the graph using Zoom to all 

Data, . 
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IV. Labeling the Graph 

Adding a Graph Title 

You can choose to add a title to your graph. 

Click or tap Graph Tools, , and choose Edit 

Graph Options. 

Add or edit the Title as desired. Click or tap 

Close, , to dismiss Graph Options. 

The title appears centered above the graph. 

 

Modifying Axes Labels 

The axis labels are populated from the column 

names. You can change the labels by changing 

the names of the columns. 

Click or tap the y-axis label, , to access 

the Plot Manager. Click or tap Column Options, 

, next to the column you want to change and 

choose Column Options. 

Change the column name as desired. Click or tap 

 to save the changes. 
 

To modify the x-axis label, , access Column Options for that column from the data table 

or temporarily plot the column on the y-axis. 
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Adding a Graph Legend 

Click or tap Graph Tools, , and select Graph 

Legend. The legend shows the point symbol, 

color, and data for each plotted column. 

Click-and-drag or touch-and-drag the legend to 

reposition it on the graph. To dismiss the legend, 

click or tap Close, . 

See Changing the Point Symbol and Trace Color 

for additional information. 
 

Rename Data Sets 

While not shown directly on the graph, data set 

names are shown in the y-axis Plot Manager and 

in the Graph Legend. 

From the data table, click or tap Data Set 

Options, , next to the data set for which you 

want to change the name. 

 

Choose Rename Data Set to change the default 

data set name. 

Click or tap  to save the data set name. 
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Add Annotations 

You can add text annotations to your graph to 

label key points or provide information about the 

data. 

Click or tap Graph Tools, , and choose Add 

Annotation to add text labels to your graph. Edit 

the text as desired. 

 

Click-and-drag or touch-and-drag an annotation 

to reposition it on the graph. 

 

Double-click or double-tap an existing 

annotation to edit the text. 

Click or tap Other Options, , to delete the 

annotation. 
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V. Modifying the Font-Size with Scale Factor 

You can modify the font size used in the app. This is particularly useful when presenting the app 

with a projector or viewing the app on a device with a high-resolution screen. 

Click or tap Other Options, , from the top tool 

bar and choose Presentation. Adjust the Scale 

Factor as desired. 

TIP! Reduce the Scale Factor when viewing 

multiple graphs to see more detail on each graph. 
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CHAPTER 6—ANALYZING YOUR DATA 

I. Examining Data Points 

Click or tap the graph to examine a point of 

interest. The coordinates of the point are shown. 

Click or tap a different point or drag the Examine 

line to further examine your data. 

To remove the Examine line, click or tap Delete 

Examine Tool, , displayed next to the line. 

 

When viewing multiple graphs, the Examine line 

displays on all graphs referencing the same 

independent variable. 

 

II. Interpolating and Extrapolating Data 

To examine values between and beyond your 

data points, click or tap Graph Tools, , and 

turn on Interpolate. 

The interpolate function affects the behavior of 

the examine cursor when examining data. 

While Interpolate is turned off, the displayed 

examine values are for plotted data points. As 

you move the Examine line, the value of the 

nearest data point is displayed. 

TIP! You cannot use Interpolate and Tangent at 

the same time. Choosing one deselects the other. 
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Interpolate Data 

While Interpolate is turned on, you can estimate values between plotted data points. The values 

displayed depend on whether or not you have a curve fit plotted on the graph. 

Interpolate Without a Curve Fit 

When there is no curve fit, the examine cursor 

follows the straight-line path between two 

consecutive points. 

 

Interpolate with a Curve Fit 

When there is a curve fit, examine follows the 

curve fit model to determine the examine values. 

 

Extrapolate Data 

To examine data beyond your data points 

(extrapolate), you must have a curve fit plotted 

on the graph and Interpolate turned on. 
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III. Exploring Rate of Change (Tangent) 

To find the rate of change of your data at any 

point, click or tap Graph Tools, , and turn on 

Tangent. 

The tangent tool calculates the rate of change of 

the data (slope) at the examined point. The 

tangent value is determined based on the points 

immediately around the examined point. 

TIP! You cannot use Interpolate and Tangent at 

the same time. Choosing one deselects the other.  

IV. Viewing Statistics 

Use the Statistics tool to calculate statistical attributes based on your data. Displayed values 

include number of points, mean, standard deviation, minimum, maximum, and range. Statistics 

for all plotted columns are calculated. 

If desired, select a region of data. If a region of 

data is not selected, the statistics tool uses all 

data in the calculation. 

 

Click or tap Graph Tools, , and select View 

Statistics. Statistics for all plotted columns on the 

graph are calculated and displayed in the 

Statistics details box. 

To dismiss the Statistics box, click or tap Close, 

. 

TIP! You can slide the Statistics box along the 

right region boundary if needed. 
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V. Viewing Integral 

Use the View Integral tool to calculate the 

numerical integral (area) associated with your 

data. 

Select a region if desired. Click or tap Graph 

Tools, , and choose View Integral to find the 

integral. The associated area is shaded, and the 

value is displayed. 

TIP! Regions above the horizontal axis (x-axis) 

are positive, while regions below are negative. 

Areas for all plotted columns are calculated and 

displayed in the Integral details box. 

 

VI. Applying a Curve Fit 

Use the curve fit tool to find a mathematical model that fits your data. Select a region first to fit a 

section of your data. When you select the tool without first selecting a region, all of the data are 

used to determine the fit model. 

Click or tap Graph Tools, , and choose Apply 

Curve Fit to find the equation of the best-fit 

curve based on your data. 

Curve fit models include Proportional, Linear, 

Quadratic, Power, Inverse, Inverse Squared, 

Natural Exponent, Natural Log, Sine, Cosine, 

and Cosine Squared. 

 

Choose a curve fit model to preview the fit to 

your data. 

TIP! If you have the Graphical Analysis Pro 

features unlocked, you can fit your data using a 

custom expression. For more information, see 

Customized Curve Fits in Chapter 8. 
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Click or tap  to display the curve fit 

equation and coefficients. Curve fits for all 

plotted columns are calculated. 

The curve fit details box includes the RMSE 

(root mean square error), a measure of how well 

the fit matches the data. Linear curve fits also 

show the correlation coefficient (r) associated 

with the linear fit. 

 

VII. Applying FFT 

Click or tap Apply FFT to perform a Fast Fourier 

Transform (FFT) analysis of time-based data. 

The Graphical Analysis Pro features must be 

unlocked to use this feature. For more 

information, see FFT Analysis, in Chapter 8. 

 

VIII. Adding Additional Columns 

Adding a Manual Column 

Add manual columns to bring in data from other files or data found on the internet to compare 

with your data. 

From the data table or Plot Manager, click or tap 

Column Options, , next to an existing column 

name. Choose Add Manual Column to create a 

new manual entry column. 

You can modify the column name, add units, and 

adjust the display precision of the new column as 

desired. For instruction on entering data in this 

column, see Entering Data in a Data Table in 

Chapter 4. 
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Adding a Calculated Column 

Calculated columns are columns with values that are based on other columns through a 

mathematical formula. For example, you might define a calculated column as the inverse square 

of another column, or you might calculate the ratio of mass and volume columns to create a 

density column, or you might use calculated columns to create potential and kinetic energy 

columns from motion sensor data columns. 

From the data table or Plot Manager, click or tap 

Column Options, , next to an existing column 

name. Choose Add Calculated Column to create 

a new column. 

You can modify the column name, add units, and 

adjust the display precision of the new column as 

desired. 

 

Click or tap  to view your 

expression options. Select the desired expression 

to use for your calculated column. 

NOTE: A, B, and C represent constants. X, Y, 

and Z represent data columns from your data 

table. 

TIP! When the Graphical Analysis Pro features 

are unlocked, you can use user-defined 

expressions in your calculated columns. See 

Custom-Expression Calculated Columns in 

Chapter 8. 
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The column from which you accessed the 

Column Options is used in the calculated column 

expression by default. Adjust the columns and 

parameters as desired. 

Click or tap  to create the column. The 

new calculated column appears to the right of the 

column used to access the Column Options. 

TIP! To edit a calculated column once it has 

been created, click or tap Column Options, , 

next to the column name in the data table or Plot 

Manager and select Column Options. 

 

IX. Managing the Data 

Deleting Columns 

From the data table or Plot Manager, click or tap 

Column Options, , next to an existing column 

name. Choose Delete Column to remove Manual 

or Calculated Columns. Sensor and time columns 

cannot be deleted. 

Click or tap  to confirm the deletion. 

Deleting a column cannot be undone. 

TIP! Since data sets are symmetric, deleting a 

column from one data set removes the 

corresponding column from all data sets. 

 

Deleting Data Sets 

From the data table, click or tap Data Set 

Options, , next to an existing data set name. 

Choose Delete Data Set to remove a data set. 

Click or tap  to confirm the deletion. 

Deleting a data set cannot be undone. 

TIP! The last created data set cannot be deleted; 

however, any entered or collected data are 

cleared. 
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CHAPTER 7—MANAGING GRAPHICAL ANALYSIS FILES 

I. Opening Files 

Click or tap the File menu, , and choose Open to display the Open file box. From here, 

you can access files stored on your device, from an accessible cloud storage location such as 

Google Drive™, iCloud®, or Dropbox, or from a connected storage device such as a USB drive or 

SD card. 

Note: Not all options are available on every platform. You can choose to open previously saved 

Graphical Analysis (.gambl or .ambl) files or comma separated value (.csv) files. 

Accessing Sample Data in Graphical Analysis 

Click or tap the File menu, , and 

choose New Experiment. Choose Sample Data to 

launch the default browser with online access to 

sample data files for Graphical Analysis. 

Sample files include data for Boyle’s Law, Ball 

Toss, Plant Transpiration, and Periodic Trends. 

 

Accessing Sample Data in Graphical Analysis Pro 

If you have unlocked the Graphical Analysis Pro 

features, you can access over 40 data-collection 

experiments that include both data and videos. 

Click or tap  to access the files. 

For more information on using the files, see 

Accessing Sample Data Experiments in Graphical 

Analysis Pro in Chapter 8. 

 

TIP! To access the sample data files available when the Graphical Analysis Pro features are 

locked, select the User Manual option listed under FROM VERNIER.COM. This accesses a web 

page that includes those sample files. 
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II. Saving Files 

Save 

Click or tap the File menu, , and choose Save to save the current file. This action 

replaces the previously saved file with the current file (in the same file location) without user 

confirmation. If your file has never been saved, selecting Save is equivalent to selecting Save As. 

Save As 

Click or tap the File menu, , and choose Save As to display the Save file box. You 

can name the file and select where the file is to be stored. You can save the file directly to your 

device, to an accessible cloud storage location such as Google Drive, iCloud, or Dropbox, or to a 

connected storage device such as a USB drive or SD card. Note: Not all options are available on 

every platform. Save As will not automatically overwrite a previously saved file. 

III. Exporting Files 

Click or tap the File menu, , and choose Export. You can choose to export graphs as 

.png files, data as .csv files, or Logger Pro compatible AMBL files. 

Graph Files (.png) 

Graph 1 is selected by default. When exporting a 

graph, you can select several options to enhance 

the exported graph file. 

• Line Shade—this option controls how dark 
the graph grid and axis lines are drawn. 

• Axis Label Size—this option controls the 
font size used for the axis labels. 

• Graph Shape—this option controls the 
aspect ratio of the graph image. 

TIP! Changes to the above settings are reflected 

on the displayed graph.  

Click or tap  to save the graph file. 

TIP! You can click or tap Copy to Clipboard, , to copy the selected graph to your device 

clipboard. Use this feature to paste your graph into a document on your device. 



Vernier Graphical Analysis™ and Graphical Analysis Pro —User Manual 

 

www.vernier.com/ga 75 

If you are displaying multiple graphs, you must 

export each graph separately. Style choices made 

for your first graph will persist for your other 

graphs. 

TIP! Use this feature to create images of your 

data for inclusion in a lab report or for 

submission to an instructor via file sharing, 

emailing, or printing. 

 

Data File (.csv) 

Choose the CSV option to export your data for 

printing your data table. 

Select the appropriate decimal separator for your 

data, then click or tap  to save 

the file. 

TIP! Use this feature to save the data in .csv 

format for further analysis with a spreadsheet 

application or to print your data. 

 

Legacy Data File (.ambl) 

Choose the AMBL option to export the data as 

an .ambl file. 

Click or tap  to save the file. 

TIP! Use this feature to create a data file that 

you can open in our Logger Pro 3 computer 

software. 
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IV. Printing from Graphical Analysis 

You cannot print directly from Graphical Analysis. To print a Graphical Analysis file, use 

FileExport to create the desired file (.csv or .png). Print the resulting file using the print 

options available on your device. 

TIP! For more information regarding printing from Graphical Analysis, see 

www.vernier.com/til/3789 

V. Starting a New Experiment File 

Click or tap the File menu, , and 

choose New Experiment to start a new file and 

reset all data-collection parameters. If you have 

unsaved data, you will be prompted to save the 

existing file before continuing. 

TIP! Wireless sensors already connected when 

selecting New Experiment remain connected 

when the new experiment is created. 

 

http://www.vernier.com/til/3789
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CHAPTER 8—GRAPHICAL ANALYSIS PRO 

I. Unlocking Graphical Analysis Pro Features 

Follow these steps to unlock the Graphical Analysis Pro features. 

1. Launch Graphical Analysis app and select a 

 Manual Entry experiment. 

 

2. Click or tap GA Pro Authorization, . 

 

3. Enter your GA Pro License Key provided to 

you by Vernier. The authorization key is case 

sensitive and must be entered exactly as it 

appears. 

 TIP! Instructors will need to distribute the 

authorization key to their students. Vernier 

will not distribute license keys to students. 
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II. Accessing Sample Experiments in Graphical Analysis Pro 

Graphical Analysis Pro comes with over 40 experiment files that are perfect for pre-experiment 

exercises, independent study, or post-experiment enrichment. The experiments, taken from our 

popular lab books, include a video of one of the data-collection trials. Experiments are available 

for middle school, biology, chemistry, and physics. 

Below are instructions for accessing and using these files. Note that you must unlock the 

Graphical Analysis Pro features in order to access the files. 

1. Launch Graphical Analysis Pro. 

 TIP! If you are already running Graphical 

Analysis Pro, click or tap the File menu, 

, and choose New Experiment to 

access the New Experiment box. 

 

4. Click or tap  to unlock the Graphical 

Analysis Pro features. 

 Note that the GA Pro Authorization button, 

, is replaced by the Data Sharing button, 

. 

 TIP! If this is the first time you are using the 

license key, you may be prompted to accept 

the End Users License Agreement before you 

can use the Graphical Analysis Pro features. 

This must be done using the email address of 

the person to whom the subscription is issued. 
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2. Click or tap  to access the 

experiment files. 

 

3. Click or tap  to quickly find 

experiments for a specific subject area and/or 

from a specific book. 

 

4. Click or tap the Subject or Book dropdown 

list, , and choose the appropriate filter. 

 TIP! You can apply multiple filters if desired. 
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5. Browse the list of experiments and locate the 

file you want to open. 

 TIP! You must have a live internet 

connection to access these files. 

 

6. Click or tap Download, , to download and 

open the experiment file. 

 TIP! If you have previously viewed a file, the 

Download button, , is replaced by a Play 

button, . 

 

 If the experiment file you open includes time-

based data, the included video and data from 

one of the trials are synced. 

 Click or tap Enable Replay, , to access the 

replay data-collection controls. Click or tap 

Start Replay, , from the replay data 

toolbar to replay both the data and synched 

video. 

 For more information, see Replaying Data 

Collection. 
 

III. Data Sharing with Graphical Analysis Pro 

Graphical Analysis Pro can serve as a Data Sharing source that can wirelessly stream sensor data 

to another device that is also running Graphical Analysis Pro. Use Graphical Analysis Pro to data 

share lecture demonstration data with your in-person class or with students studying remotely, so 

they can independently analyze the data. Students in lab groups can also data share with their lab 

partners so everyone in the lab group has a copy of the data. 
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Setting up Graphical Analysis Pro as the Data Sharing Host 

1. Make sure your device has a live internet 

connection. 

 Launch Graphical Analysis and set up a 

sensor data-collection experiment using 

sensors. 

 TIP! It is not necessary to collect data before 

setting up a Data Sharing source; however, if 

data have already been collected, devices get 

that data when they connect, confirming the 

connection is successful.  

2. Click or tap the Data Sharing, , to access 

the data sharing setup box. 

 

3. Click or tap  to initiate data 

sharing from your device. A unique six-

character ID code is generated. Share this 

code with everyone to which you are data 

sharing. 

 TIP! The ID code consists of five lower-case 

letters and a number (e.g., abc4ef; the fourth 

character is always a number). 
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4. Click or tap Full Screen, , to display the 

code full screen. This is useful if you are 

displaying your screen live. 

 Click or tap Full Screen, , again to exit 

the full-screen display of the code. 

 TIP! You can also click or tap Copy, , to 

copy the code to your device clipboard. Use 

this feature to paste the code in an email, text 

message, or meeting chat for sharing with 

others. 
 

 

5. Click or tap Close, , to exit the setup 

screen and continue with your experiment. 

 Note that the Data Sharing button now has a 

green dot, . This indicates that your 

device is actively sharing data. 

 TIP! Click or tap Data Sharing, , to 

access the data sharing ID again or to see 

how many devices to which you are currently 

data sharing. 
 

6. Click or tap  to end the 

data sharing session. 

 TIP! The data share ID number changes 

every time you start a new data sharing 

session. If you stop sharing inadvertently, you 

need to send out the new data sharing ID 

after you start the new session. 

 

Connecting to a Graphical Analysis Pro Data Sharing Source 

See Connecting to a Graphical Analysis Pro Data Sharing Source in Chapter 3. 

IV. Replaying Time-Based Data Collections 

Graphical Analysis Pro provides the tools to replay data from a time-based data collection. This 

feature is only available for time-based sensor data and is most useful when paired with a video 

synced to the collection. For more details, see Syncing a Video to a Time-Based Data Collection. 
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1. Collect some time-based sensor data or open 

a data file containing time-based sensor data. 

Notice that Enable Replay, , is shown on 

the top bar. 

 

2. Click or tap Enable Replay, , to access the 

replay tools. This sets the replay time to zero, 

hiding the collected data. 

 TIP! If you have more than one data set, 

click or tap the data set dropdown menu to 

select the data set you want to replay. If you 

change data sets, be sure the data set you 

want to replay is selected to plot on your 

graph. 

 

3. Click or tap Playback Speed, , to set 

the data-collection replay speed. Maximum 

replay speed is 1000× normal speed. To make 

the replay slower than normal, enter a value 

between 0 and 1. 

• Click or tap Start Replay, , to replay 

the data collection. 

• Click or tap Pause Replay, , to pause 

the replay. 

• Click or tap Restart Replay, , to 

replay the collection from the beginning. 

 

• Click or tap Step Backward, , and Step Forward, , to rewind or advance the replay 

by one time-unit. 

• Click or tap Close Replay, , to exit replay. 

 

Sync Video to Data, , is used for syncing data-collection replay to a video. For more 

information, see Syncing a Video to a Time-Based Data Collection. 
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V. Adding a Video to a Graphical Analysis Pro Data File 

You can enhance your Graphical Analysis data file by including a video of your experiment. 

Capture the video using your computer camera or phone, and import the video into Graphical 

Analysis Pro. 

Videos of time-based data collection experiments can be synchronized with the data collection in 

Graphical Analysis Pro. For more information, see Syncing a Video to a Time-Based Data 

Collection. 

1. Start a new data file or open an existing file. 

 

2. Click or tap View Options, , and turn on 

Video. 

 TIP! You must have the Graphical Analysis 

Pro features unlocked to display a video. 

 

3. Click or tap , browse to the 

video on your device, and import it. 

 TIP! You can resize the split between the 

video and the graph as needed by dragging 

the handle on the separator bar, 

. 
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4. Use the replay tools, as indicated below. 

• Click or tap Start Replay, , to play the 

video. 

• Click or tap Pause Replay, , to pause 

the video. 

• Click or tap Restart Replay, , to 

replay the video from the beginning. 

• Click or tap Step Backward, , and 

Step Forward, , to rewind or advance 

the video frame by frame. 

 

• Control the video manually by adjusting the video slider, . 

• Click or tap Audio, , to play the video’s audio track during playback. Click or tap 

Audio again, , to mute the audio during playback. 

 

Click or tap the Picture-in-Picture, , to 

display the video in a floating display that you 

can resize and reposition. This feature is not 

available for all platforms and all operating 

systems. 

To play the video from the picture-in-picture 

frame, click or tap the video and select Start 

Replay, ►. 

To exit the picture-in-picture mode, click or tap 

the video and select Close, ×. 
 

Click or tap Delete Video, , to remove the video from the file. 
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VI. Syncing a Video to a Time-Based Data Collection 

1. Capture a video of a time-based sensor data-

collection experiment and import the video 

into the Graphical Analysis Pro data file. 

 For more information, see Adding a Video to 

a Graphical Analysis Pro Data File. 

 

2. Click or tap Enable Replay, , to access the 

replay data-collection tools. 

 

3. Click or tap Start Replay, , from the 

replay data toolbar to replay the data 

collection so you can again see all of the data. 
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4. Click or tap Sync Video to Data, , to 

access the sync video tools. 

 

5. Advance the video to a frame that you can 

easily correlate to one of the data points. 

 For example, in the video shown here, the 

frame where the jumper first steps on the 

force plate correlates to a point where the 

force starts to increase. 

 

6. Click or tap the graph at the point that 

corresponds to the video frame you have 

selected. 
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7. Click or tap Sync data with video, , to 

turn on the sync tool. 

• Enter the time associated with the 
examine line as the Data Set Time. 

• Enter the time associated with the current 
video frame as the Video Time. 

 

8. Click or tap Sync Video to Data, , to 

close the sync video tool. 

 Click or tap Restart Replay, , from the 

replay data toolbar. Note that because they 

are synched, both the data and the video reset 

to the start of data collection. 

 TIP! Using Restart Replay, , from the 

video tools only rewinds the video. 

 

9. Click or tap Playback Speed, , and 

set the replay speed as desired. The 

maximum replay speed for a synced video is 

16× normal speed. 

 Click or tap Start Replay, , from the 

replay data toolbar to replay the data 

collection and synched video at the same 

time. 

 TIP! Using Start Replay, , from the video 

tools only plays the video. 
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 10. When data collection is complete, you can 
tap to examine a data point and the 
corresponding video frame. 

 TIP! Because they are synched, dragging the 

examine line also controls the video so that 

the displayed video frame corresponds to the 

examined data point. 

 

VII. Customized Curve Fits 

You can create a custom curve fit expression by modifying an existing expression or entering a 

new expression. The independent variable, x, is used to represent the data column plotted on the 

horizontal axis. Parameter labels can be one or more letters (except x) and are case sensitive. 

1. If desired, select a region of data, then click 

or tap Graph Tools, , and choose Apply 

Curve Fit.  

 TIP! You can select a curve fit model with an 

expression that is most similar to the one you 

want to enter. This can make entering your 

expression easier. 

 

2. Click or tap Create Custom Fit to enter a 

custom fit expression. Modify the expression 

as needed. 

 TIP! You can click or tap Info, , for 

in-app access to the details related to 

entering an expression. 

 

Supported Operators: + – * / ^ ( ) 

Supported Functions: exp( ), ln( ), log( ), sqrt( ), sin( ), cos( ), tan( ) 
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Example Expressions: 

• Modified Linear: A + B*x  or  slope*x + intercept 

• Modified Quadratic: A(x – h)^2 + k  or  A(x–a)(x–b) 

• Base-10 Exponent: A*10^(Bx + C) + D 

• Gaussian: A*exp(– (x–B)^2/C^2) + D 
 

Expression Details: 

• An expression must include the independent variable and at least one parameter. 

• Functions and the independent variable must be lower case. [sin(x) not SIN(x) or 
sin(X)] 

• There can be no more than six parameters in an expression. 

• Multiplication can be explicit or implied. [A*x or Ax] 

• Parameters cannot be repeated within an expression. [A(x + y) not Ax + Ay] 

• Trigonometric functions are evaluated in radians except when the column plotted on the 
horizontal axis has units—°, deg, or degrees. 

 

3. Add a name for your fit, if desired. If you do 

not add a name, the expression is used as the 

fit name. 

 

4. Click or tap  to apply the fit you 

your data.  
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Once you have applied a custom fit to your data, 

you can use that curve fit expression to fit other 

data collected in the current file. 

Custom curve fit expressions are saved along 

with the data and other experiment settings 

when you save the Graphical Analysis Pro 

(.gambl) file. 

 

Note: Custom curve fits are only accessible in the file in which they are created. Starting a new 

experiment, opening a different file, or restarting the app will remove the custom curve fit from 

Graphical Analysis Pro. 

VIII. Custom-Expression Calculated Columns 

Calculated columns are columns with values that are based on other columns through a 

mathematical formula. With Graphical Analysis Pro, you can use specialized functions to define 

custom expressions when creating calculated columns. This functionality extends your options 

when defining the calculated column expression. 

1. From the data table or y-axis Plot Manager, 

click or tap Column Options, , next to an 

existing column name. Choose Add 

Calculated Column to create a new column. 

 You can modify the column name, add units, 

and adjust the display precision of the new 

column as desired. 
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2. Click or tap  to view your 

expression options. 

 Click or tap  to create a 

custom expression. 

 

3. Enter the expression as desired. 

 Note: The expression is checked for errors as 

it is entered. You must fix any errors before 

applying the expression. 

 

 

4. Click or tap  to reference a 

column of data in the expression. The column 

name can be entered by hand, but it must be 

in quotes and exactly match the name as 

displayed in the data table or in the Plot 

Manager. 

 TIP! When there are multiple data sets, the 

column name refers to the column within that 

data set only. 
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5. Click or tap  to create the calculated 

column. 

 TIP! To edit a calculated column once it has 

been created, click or tap Column Options, 

, next to the column name in the data 

table or y-axis Plot Manager and choose 

Column Options. 

 

When entering an expression, click or tap 

 to access a library of functions 

available for your custom expression. Available 

functions include the following: 

• Common math functions including square 
root, cube root, power, exponential, and 
logarithmic functions 

• Trigonometric functions including inverse 
and hyperbolic trigonometric functions 

• Number sense functions including absolute 
value, round, truncate, ceiling, floor, and 
modulo 

 

 

Calculated Column Custom Expression Details 

• An expression must be a number, a data column, an appropriately formatted function, or a 
combination of these items. [5, “X”, sin(“X”), or 5sin(“X”)] 

• Supported operators are as follows: +, –, *, /, ^, (, and ). 

• Functions must contain their arguments in parentheses. [abs(“X”) or sqrt(2)] 

• Multiplication can be explicit and implied. [5*“X” or 5“X” or 5(“X”)] 

• Constants must be entered as numbers. Variable parameters (e.g., A, B, C) are not supported. 

• Trigonometric functions are evaluated in radians. 

• Functions can be nested as long as the proper format is used. [sqrt(abs(“X”))] 

 

For a complete list of functions and their syntax, see https://www.vernier.com/til/11314. 

  

https://www.vernier.com/til/11314
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IX. FFT Analysis 

Graphical Analysis Pro includes the option to perform a Fast Fourier Transform (FFT) analysis 

of time-based data. FFTs are commonly used to analyze the frequencies found in microphone 

data and can be used to identify electronic noise in non-sinusoidal analog sensor data. 

Click or tap Graph Tools, , and choose Apply 

FFT to create an FFT bar graph based to your 

data. 

TIP! If you select a region of data prior to 

accessing Graph Tools, the FFT analysis is 

based on the selected data only. 

 

The FFT bar graph displays the amplitudes of the 

frequencies of the sine wave components that 

make up the data. The FFT graph legend shows 

the peak frequency found in the data. 

To dismiss the FFT analysis, click or tap Close 

FFT, , from the FFT tools, . 

 

Use the FFT tools, , to access 

options available with an FFT Analysis. 

Click or tap Show Original Graph, , from the 

FFT tools to toggle the view to the original data 

without removing the FFT analysis. 

Click or tap Show FFT, , to toggle the view 

back to the FFT bar graph. 
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To view a graph of the FFT analysis and the data 

upon which it is based at the same time, use View 

Options, , to manually set up a second graph 

that show the original data. 

 

When viewing the FFT analysis, the options 

available from the Graph Tools menu, , are 

limited to hiding/showing the graph legend and 

manually adjusting the graph axes ranges. 

 

Click or tap FFT Settings, , to adjust the 

default FFT options, which are selected by 

default. 

Remove Linear Trend 

When selected, the Remove Linear Trend option 

ignores any linearly-changing offset in the data. 

Such an offset could appear as a spurious low-

frequency component in the FFT. 

Use Windowing 

Windowing is a technique used to minimize edge 

effects that result in spectral broadening in the 

FFT. The Use Windowing option applies a 

Hanning window to the data before the FFT is 

performed. 
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CHAPTER 9—APPENDIX 

I. Updating Graphical Analysis 

Determining Your Software Version 

Click or tap Other Options, , from the top 

toolbar, and choose About to see what Graphical 

Analysis version you are running. 

When using computers, the About box also 

provides a way to check for updates. 

 

When you have unlocked the Graphical Analysis 

Pro features, the About box provides a way to 

update your Graphical Analysis Pro Key. For 

more information, see Updating the Graphical 

Analysis Pro Key. 

 

Check for Updates (Computers Only) 

Click or tap Other Options, , from the top 

toolbar, and choose Check For Updates to ensure 

you are running the latest version of Graphical 

Analysis. You can choose to update if a newer 

version is available. This option requires your 

device to have an active internet connection. 

TIP! This option is displayed for computers only. 

Chrome OS, iOS, iPadOS, and Android versions 

automatically check for and apply updates. 
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Graphical Analysis automatically checks for updates when your computer has an internet 

connection. When an update is available, the Check for Updates option is replaced with Update 

Available. Follow the steps below to update Graphical Analysis. 

1. Click or tap Other Options, , from the top 

toolbar and select ● Update Available. 

 

2. Click or tap  to 

download the update. 

 

3. The app must restart for the update to install. 

Click or tap  to complete the 

update. 
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What’s New 

Click or tap Other Options, , from the top 

toolbar, and choose What’s New to view a 

summary of the new features and fixes available 

in the most recent version of Graphical Analysis. 

Click or tap  to see changes 

made in previous versions. 

 

 

II. Updating the Graphical Analysis Pro Key 

Graphical Analysis Pro features are subscription-based. Updating the key is required to continue 

using the software when a subscription expires. 

30 days prior to the expiration of your current 

license key, an expiration reminder is displayed 

when you launch Graphical Analysis. 

TIP! This warning is always shown when using a 

30-day free trial of Graphical Analysis Pro. 

 

When you are within 15 days of expiration, the 

warning is displayed in red. 
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Follow these steps to update your Graphical Analysis key from a free trial to a paid subscription 

or to update an expiring subscription to a new subscription. 

1. Click or tap Other Options, , from the top 

toolbar and choose About. 

 

2. Click or tap , enter the 

new key, and click or tap . 

 You can continue to use the Graphical 

Analysis Pro features. 

 CAUTION! If you enter an invalid key, your 

Graphical Analysis Pro features again 

become locked. Enter a valid key or restart 

the app to continue to use the Graphical 

Analysis Pro features using the original key.  

III. Sharing the Graphical Analysis Pro License Key 

There are several ways in which you can share the Graphical Analysis Pro license key. 

• Share the email you received from Vernier 

that includes the license key with your 

colleagues. 

 

The Graphical Analysis Pro license covers all 

faculty and student devices in a K–12 school 

or college department. 
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• Access the license key from the Vernier web 

account of the license owner. The license 

owner is the person that purchased the 

software and received the original email from 

Vernier. 

 

• Email the key to your students or post it on a 

secure website that only your students and 

colleagues can access. 

 

TIP! Copy the Authorize Graphical Analysis 

Pro link and share that link with your 

students that already have Graphical 

Analysis installed on their devices. Opening 

the link opens Graphical Analysis with the 

Pro features already unlocked. 
 

 

IV. Updating the Firmware on a Go Direct Sensor 

Graphical Analysis automatically checks the 

firmware version of a sensor when the sensor is 

connected. 

Sensors that have an available firmware update 

are indicted by the following button

. 

A firmware update can only be applied when the 

sensor is connected to a computer or 

Chromebook via USB. The firmware cannot be 

updated via a wireless connection. 
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Click or tap

 to start 

the firmware update for that sensor. 

Because Graphical Analysis cannot be running 

while a sensor is updating, click or tap 

 to continue 

with the Go Direct Firmware Updater 

application. 

 

Click or tap  to update the 

sensor. 

Firmware updates take about two minutes to 

complete. Progress is indicated via a progress 

meter next to each sensor being updated.  

  

Once the firmware update is complete, the 

updated firmware version is shown in the box. 

 

Once all sensors are updated, click or tap 

, and continue with 

your experiment. 
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V. Getting Additional Help 

Accessing the User Manual 

Click or tap Other Options, , from the top toolbar and choose User Manual to access the user 

manual as well as online video tutorials for some Graphical Analysis features. This option 

requires your device to have a live internet connection. 

For access to other user manuals, our 

Technology Information Library, and chat, 

visit our website: 

www.vernier.com/support 

You may also contact Vernier directly by 

phone or email: 

Toll Free: 888.837.6437 

Email: support@vernier.com 

 

Curriculum Resources from Vernier Software & Technology 

Vernier offers a complete set of lab books for elementary through college. For more information, 

see www.vernier.com/books. 
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